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About This Manual

This manual provides information about the Order Analysis Toolset for
LabVIEW, including system requirements, installation, and suggestions
for getting started with order analysis and the toolset. The manual also
provides a brief discussion of the order analysis process and the algorithm
used by the Order Analysis Toolset for LabVIEW.

Conventions
The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

bold Bold text denotes items that you must select or click on in the software,
such as menu items and dialog box options. Bold text also denotes the
names of parameters, dialog boxes, sections of dialog boxes, windows,
menus, palettes, and front panel controls and buttons.

italic Italic text denotes a cross reference.

monospace Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

Related Documentation
The following documents contain information that you might find helpful
as you read this manual:

• Order Analysis Toolset for LabVIEW Help, available by selecting
Help»Order Analysis

• Getting Started with LabVIEW
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• LabVIEW User Manual

• LabVIEW Help, available by selecting Help»Contents and Index
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1
Introduction

This chapter introduces the Order Analysis Toolset for LabVIEW and the
Order Analysis Start-Up Kit, outlines system requirements, and gives
installation instructions. The CD in your software package contains the
Order Analysis Toolset for LabVIEW and the Order Analysis Start-Up Kit.

Order Analysis Toolset for LabVIEW
The Order Analysis Toolset for LabVIEW is a collection of virtual
instruments (VIs) for LabVIEW. These VIs help you measure and analyze
noise or vibration signals generated by rotating machinery. The Order
Analysis Toolset for LabVIEW provides tools to assist you in completing
the following analyses:

• Calculation and examination of rotational speed

• Measurement of the power distribution in the frequency domain or in
the order domain as a function of either time or rotational speed

• Extraction of the order components from the original noise or vibration
signal

• Measurement of the overall level of any order component as a function
of rotational speed

The Order Analysis Toolset for LabVIEW includes easy, intermediate, and
advanced VIs. The easy VIs and the intermediate VIs are built from the
advanced VIs and group the advanced VIs into a tidy, logical sequence. Use
the easy and intermediate VIs to perform simple tasks in just a few steps.
For experienced LabVIEW users, the advanced VIs provide flexibility and
increased control of the analysis process. Refer to the Order Analysis
Toolset for LabVIEW Help, available by selecting Help»Order Analysis,
for more information about individual VIs.
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Using the Order Analysis Toolset in the Analysis of Rotating Machinery
Order analysis is a powerful tool for analyzing rotating machinery when the
rotational speed may change over time. However, to successfully use the
Order Analysis Toolset for LabVIEW, you must observe the following
condition and restriction:

• A signal directly related to the fundamental rotational speed must be
provided, such as a pulse train from a tachometer.

• Do not use the Order Analysis Toolset for LabVIEW for analysis of
frequencies not excited by a fundamental frequency, such as the modes
encountered in modal analysis. Although the different modes in the
frequency domain can be observed, there is no simple relationship
among those different modes. Usually, the frequencies of different
modes are not simply a multiple of a fundamental frequency over time.

Order Analysis Start-Up Kit
The Order Analysis Start-Up Kit is automatically installed when you install
the Order Analysis Toolset for LabVIEW. The Start-Up Kit includes a
LabVIEW application for order analysis and source code. The application
is built with components found in the Order Analysis Toolset for
LabVIEW.

The simple processes included in the application enable you to perform
data acquisition, tachometer analysis, and order analysis on the noise or
vibration signals generated by rotating machinery. This application
provides an example of how the Order Analysis Toolset for LabVIEW can
help you successfully complete your analysis projects. You also can use it
as a simple order analysis VI in your own projects or as a tool to learn the
basics of building and using Order Analysis Toolset for LabVIEW VIs.
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Getting Started
If you are just beginning to gain experience with order analysis, read
Chapter 2, Introduction to Order Analysis, of this manual and experiment
with the Order Analysis Start-Up Kit. Chapter 2, Introduction to Order
Analysis, provides basic information about order analysis that you might
find useful. The Order Analysis Start-Up Kit gives you the opportunity to
see how the Order Analysis Toolset for LabVIEW can help in your analysis
of the noise and vibration generated by rotating machinery.

Refer to Chapter 3, Order Analysis Algorithm, of this manual for a brief
description of the algorithm used in the Order Analysis Toolset for
LabVIEW.

If you have experience with order analysis, the example VIs can help you
learn how to use the Order Analysis Toolset for LabVIEW. Refer to
Chapter 4, Example VIs, in this manual for information about the example
VIs.

Refer to the Order Analysis Toolset Help, available by selecting
Help»Order Analysis, for information about individual VIs.

System Requirements
The following are the minimum system requirements needed to run the
Order Analysis Toolset for LabVIEW:

• Pentium 233 or faster processor

• 64 MB of RAM minimum, 128 MB of RAM recommended

• 20 MB of disk storage space for full installation

• Microsoft Windows 95 or later or Microsoft Windows NT 4.0 or later
with service pack 3

• LabVIEW 6.0 or later Full Development System or Professional
Development System

Note Order analysis is a memory-intensive task, especially when you apply maps.
Increasing the amount of RAM in your system can significantly increase system
performance.
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Installation
This section describes the procedures for installing the Order Analysis
Toolset for LabVIEW.

Windows 95/98/Me
Complete the following steps to install the Order Analysis Toolset for
LabVIEW on a computer running Windows 95, 98, or Me.

1. Insert the Order Analysis Toolset for LabVIEW CD into the CD-ROM
drive.

2. The installation program will run automatically if the autoplay feature
in Windows is enabled. If the installation program does not start
automatically, run setup.exe in the Toolset directory on the CD.

3. Follow the instructions that appear on your screen.

Windows NT/2000
Complete the following steps to install the Order Analysis Toolset for
LabVIEW on a computer running Windows NT or Windows 2000.

1. Log on to Windows as an administrator or as a user with administrator
privileges.

2. Insert the Order Analysis Toolset for LabVIEW CD into the CD-ROM
drive.

3. The installation program will run automatically if the autoplay feature
in Windows is enabled. If the installation program does not start
automatically, run setup.exe in the Toolset directory on the CD.

4. Follow the instructions that appear on your screen.
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2
Introduction to Order Analysis

Often, it is neither possible nor desirable to physically open up a system and
study it. In many such instances, we can gain knowledge about a system by
measuring and analyzing signals associated with the system. For example,
physicists and chemists use the spectrum generated by a prism to
distinguish between different types of matter. Astronomers apply spectra,
as well as the Doppler effect, to determine distances between planets.
Physicians use the electrocardiograph (ECG), which traces the electrical
activity of the heart, as a nonsurgical means of diagnosing heart problems.
Signal analysis is a fundamental tool for understanding nature.

The analysis techniques provided by the Order Analysis Toolset for
LabVIEW can assist engineers and scientists in the study, design, and
monitoring of rotating machinery. With this toolset, engineers and
scientists can better understand, through sound or vibration signals,
systems that include rotational components, systems such as automobiles,
airplanes, air conditioners, and PC hard drives. The automotive and other
industries refer to the techniques included with this software as order
analysis.

Order Analysis Fundamentals
Order analysis and harmonic analysis have much in common. The term
harmonic refers to frequencies that are integer or fractional multiples of a
fundamental frequency. When dealing with rotating machinery, you can
often hear noise and feel vibration created by the parts, such as bearings,
gears, and blades, associated with the rotating components. Vibration of the
rotating components creates noise and vibration signals. The machine
rotational speed is the source of these signals, and the frequency-domain
representations of noise and vibration behave as harmonics of the machine
rotational speed. In many industries, the harmonics related to the rotational
speed are referred to as orders, and the corresponding harmonic analysis is
called order analysis. The harmonic at the same frequency as that of the
rotational speed is the first order; the harmonic at twice the frequency of
the rotational speed is the second order and so on. Therefore, in one sense,
order analysis can be thought of as an application of harmonic analysis for
rotating machinery.
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Figure 2-1 shows the relationship between frequency and order spectra.
The top graph of Figure 2-1 shows a vibration signal from a machine
running at 3000 revolutions per minute (RPM). The rotational speed is
computed from the tachometer signal, which is shown as the second graph.
Assuming that speed remains constant during data acquisition, we can
easily switch from the frequency domain to the order domain and vice versa
by using the following formulas:

Figure 2-1. Order and Frequency Domain Display of a Shaft Rotating at 3000 RPM

The orders often reflect the physical characteristics of rotating machines.
As in classical harmonic analysis, by analyzing the phase and amplitude
relationships between different orders, engineers and scientists often can
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discover a great deal about the system in which they are interested. For
example, the following relationships have been observed:

• Imbalance results in a spectral peak at the first order.

• Misalignment or bending of the shaft generates a large second order.

• Oil whirl might lead to strong fractional orders.

• Gears, belts, and blades might enhance high orders.

Figure 2-2 shows the order spectrum of the vibration signal measured from
a PC fan with seven blades and four coils. In Figure 2-2, there are strong
fourth and seventh orders. The four coils inside the fan drag and push the
shaft four times per revolution, causing the strong fourth order. The strong
seventh order is caused by the seven blades, which pass the position of the
sensor seven times per revolution.

Figure 2-2. Order Spectrum of a PC Fan with Seven Blades and Four Coils

Like classical harmonic analysis, order analysis is a powerful tool for
engineers and scientists to better understand the condition of rotating
machinery. Compared to harmonic analysis, however, order analysis is
more effective for the analysis of rotating machinery. Order analysis can be
used when a machine runs at a constant speed or when the rotational speed
varies.

Orders
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Comparison of Order Analysis and Harmonic Analysis
In classical harmonic analysis, it is well understood that the fundamental
frequency does not change over time. Although the phases and amplitudes
of the individual harmonics can vary over time, the center frequencies of
all the harmonics are constant. In other words, harmonic analysis is only
suitable for rotating machinery when the rotational speed remains constant.

At a constant speed, orders can be well identified from both the
conventional power spectrum and the frequency-time spectral map.
Figure 2-3 depicts the analysis of a vibration signal acquired from a PC fan
running at a constant speed. The bottom plot depicts the tachometer pulses
and the signal from an accelerometer mounted on the fan. The plot on the
left illustrates a conventional power spectrum based on the fast Fourier
transform (FFT). The upper-right plot shows the frequency-time spectral
map computed from the short-time Fourier transform (STFT) with a
1024-point Hanning window. Because the fan rotated at a constant speed
during data acquisition, we can identify several peaks in both the power
spectrum and the frequency-time spectral map. These peaks indicate
different orders and appear in the STFT as white lines.



Chapter 2 Introduction to Order Analysis

© National Instruments Corporation 2-5 Order Analysis Toolset User Manual

Figure 2-3. Fan Runs at Constant RPM

In addition to rotating machinery running at a constant speed, in practical
applications, engineers and scientists are often interested in tests involving
run-up and run-down. Like a swept-sine stimulus, testing run-up and
run-down provides a stimulus over a wide range of frequencies. Run-up and
run-down is a standard procedure for testing rotating machinery in many
industrial applications.

What happens in the conventional power spectrum if the rotational speed
changes? Fourier analysis theory tells us that the frequency bandwidth of a
signal is proportional to the change in the frequency and amplitude of that
signal. The faster the frequency changes, the wider the overall frequency
bandwidth becomes, as measured from the power spectrum.
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Figure 2-4 illustrates a conventional power spectrum on the left and the
frequency-time spectral map on the right for a signal with constant
frequency and amplitude. The overall frequency bandwidth is proportional
to the change in frequencies. When the frequency and amplitude are
constant with time, the overall frequency bandwidth, as measured from the
conventional power spectrum, will be the minimum.

Figure 2-4. A Constant Frequency

Figure 2-5 depicts a signal with frequency content that changes as a
function of time. Although at each time instant the signals in Figure 2-4 and
Figure 2-5 have similar frequency bandwidths, the overall frequency
bandwidths, shown in their corresponding power spectra, are rather
different. As you can see from the two FFT-based power spectra in
Figures 2-4 and 2-5, the overall frequency bandwidth of the signal whose
frequency increases with time in Figure 2-5 is much wider than that of the
signal whose frequency is constant in Figure 2-4. When frequency or
amplitude vary with time, the corresponding overall frequency bandwidth,
as measured from the conventional power spectrum, becomes wide.
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Figure 2-5. Frequency Changes Over Time

When the frequency bandwidth of the fundamental component widens, the
bandwidths of the associated harmonics also widen. This spreading will
eventually cause the frequency bandwidth of the harmonics to overlap in
the conventional power spectrum. In this case, we will no longer be able to
identify different harmonics from the power spectrum.

Figure 2-6 shows the signal from the same PC fan as the one depicted in
Figure 2-3. However, in Figure 2-6, the rotational speed of the fan increases
with time. As the rotational speed increases, both the fundamental
frequency bandwidth and the frequency bandwidths of related orders
widen, causing orders to overlap. Whether or not you can separate nearby
orders in a power spectrum depends upon the rate of change in the
rotational speed, the window used, and the highest order of interest. In
Figure 2-6, the power spectrum has been measured over the entire duration
of the fan run-up and does not really show any distinguishable orders.
When the change of speed is large enough, the spectrum of orders will
eventually overlap. Consequently, there will be no way to derive
meaningful information about the individual orders.
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Figure 2-6. Fan Run-Up

When using the Fourier transform, you obtain the best results with the
machine running at a constant speed while taking measurements. If you
want to take measurements at a different speed, you have to run the machine
to that speed and take another measurement. Such testing with discrete
increments is time consuming and can be impossible when the speed
cannot be well-controlled or the system is not allowed to run at the critical
speed for a sufficient length of time.

One of the most important goals of order analysis is to uncover information
about the orders that might become buried in the power spectrum due to a
change in rotational speed. This goal is a central topic in the rest of this
manual. While the orders are hidden in the overall power spectrum in
Figure 2-6, we will see that they have distinguishable features in the
frequency-time spectral map. This observation is the starting point for
uncovering information about orders which are difficult to see in the power
spectrum.
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Applications of Order Analysis
In general, applying order analysis to noise or vibration data enables you to
accomplish the following goals:

• Associating features of noise and vibration to the physical
characteristics of machines

• Identifying characteristics that change with time and operating
conditions, which is useful for machine troubleshooting, design,
synthesis, and test and lifetime monitoring

Refer to the Using the Order Analysis Toolset in the Analysis of Rotating
Machinery section in Chapter 1, Introduction, of this manual for
information about a condition and restriction for using the Order Analysis
Toolset for LabVIEW to analyze rotating machinery.
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3
Order Analysis Algorithm

This chapter briefly discusses different methods of performing order
analysis and introduces the algorithm used by the Order Analysis Toolset
for LabVIEW.

Order Analysis Methods
The basic technique of order analysis involves obtaining the instantaneous
speed of the rotating shaft of a machine from a tachometer or encoder
signal. The speed is then correlated to the noise or vibration signal
produced by the machine to obtain information about the order components
such as waveforms, magnitudes, and phases. In order analysis, we focus on
revolutions, rather than time, as the basis for signal analysis. Thus, in the
spectrum domain, the focus is on orders rather than frequency components.

Currently, the following methods are generally used to perform order
analysis:

• Re-sampling

• Adaptive filter

• Gabor transform

The Order Analysis Toolset for LabVIEW uses the Gabor transform
method of order analysis.

Re-Sampling
Re-sampling is one of the most widely used solutions for order analysis.
Figure 3-1 illustrates the re-sampling method. In the re-sampling method,
time-samples are converted to angle-samples. The time-samples are
samples of the physical signal which are equally spaced in time. The
angle-samples are samples which are equally spaced in the rotation angle.
The order components may then be analyzed by performing a traditional
analysis method, such as the Fourier transform, on the angle-samples.
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Figure 3-1. Re-Sampling

Angle-samples can be acquired by either hardware or software. The
hardware solution uses an encoder or a multiplied tachometer signal to
trigger the analog-to-digital conversion, which ensures a sampling process
spaced equally in the rotation angle. This solution must use additional
hardware devices and requires a tracking anti-aliasing filter.

The software solution first collects the measured signal and the tachometer
signal at some constant rate. Then, interpolation or curve fitting is used to
determine the instantaneous shaft angle at intermediate points between the
tachometer pulses. The sampling time at the desired shaft-angular
increment can then be calculated, and interpolation can be used to obtain
new samples at the desired time.

After the angle-samples are obtained, they can be analyzed by performing
a Fourier transform on them. Since the time domain has changed into the
angle domain, the frequency domain now becomes the order domain. Thus,
the order components can be separated and easily observed through either
the order spectrum, which is actually the FFT spectrum, or the STFT
spectrum.

Figure 3-2 shows the spectrum of angle-samples. The bottom plot, labeled
Angle Samples, is the signal sampled at a constant angle-interval. The plot
on the upper left, labeled Order Spectrum, shows the order spectrum by
performing an FFT on the angle-samples. In the Order Spectrum plot,
significant peaks appear at each order. At the top right, labeled Order vs.

Sample at Constant Time Frequency

Sample at Constant Angle Order
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Rev, is the result of a STFT on the angle-samples, where an order axis is
used instead of a frequency axis. Each horizontal white line indicates the
strong power at an integer order.

Figure 3-2. Spectrum of Angle-Samples

After the resampling process has taken place, recovery of a time waveform
at a specific order can be difficult.

Adaptive Filter
Although the frequencies of the order components change as the rotational
speed changes, in a relatively short time interval, the rotational speed and
the frequency of order components can be considered to remain constant.
The adaptive filter method of order analysis uses a band pass filter whose
pass band frequency shifts according to the rotational speed and filters out
the desired order.

The Vold-Kalman Order Tracking Filter is an example of the successful
application of the adaptive filter method. With an accurate instantaneous
speed signal as a guide, the Vold-Kalman Order Tracking Filter can extract
two orders which are in close proximity to each other without ambiguity.
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Gabor Transform
Gabor transform is one of the invertible joint time-frequency transforms.
This means that any time-domain input signal, or an approximation thereof,
can be recovered from its transform result by applying an inverse Gabor
transform. The transform result is called a Gabor coefficient, and the
inverse Gabor transform is known as Gabor expansion.

Gabor transform can be computed by short-time Fourier transform (STFT)
or windowed Fourier transform. However, to ensure reconstruction, you
have to take good care of the analysis window, the window shift step, or
data blocks, and the signal edges. The following methods are used to ensure
reconstruction:

• The ratio between the length of the analysis window and the window
shift step must be greater than or equal to one. This ratio determines
the time overlap. By default in the Order Analysis Toolset for
LabVIEW, the ratio is set to four. For example, if the window length is
2048, then the window shift is 512.

• The analysis window has to be moved in such way that no information
will be missed, especially at the beginning and the end of the data
samples. Zero padding and wrap padding are two commonly used
methods for dealing with the edge data.

In zero padding, as shown in Figure 3-3(a), the first window, as well as the
last window, only covers one data block. The remaining area in the range
of the window is filled with zeros. Thus, extra data samples are added. After
Gabor expansion, the reconstructed data will be longer than the original
data.

To avoid the reconstructed data being longer than the original data, an
alternative is to consider the signal as periodic and use wrap padding. In
wrap padding, when the first few data blocks are analyzed, data blocks at
the end of the data samples are wrapped ahead to fill the windows. Data
blocks may also be wrapped backward from the beginning of the data
sample to the end. Figure 3-3(b) illustrates the wrap padding method.
Figure 3-4 shows two examples of padding.
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Figure 3-3. Padding Schemes

Figure 3-4. Padding Examples

The Gabor transform can be thought of as a specific STFT. While the signal
can be recovered from its Gabor transform by means of the Gabor
expansion, the general STFT cannot be reconstructed by inverse Fourier
transform.
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There are several other technical details concerning the computation of
the Gabor transform. Refer to Appendix A, Gabor Expansion and
Gabor Transform, of this manual for more information about the Gabor
transform and the Gabor expansion.

Overview of the Order Analysis Toolset Algorithm
Based on the Gabor transform, the Order Analysis Toolset for LabVIEW
provides a new method which enables you to complete the following tasks:

• Analyze the order components of a noise or vibration signal

• Reconstruct the desired order components in the time-domain

The Gabor transform can give the power distribution of the original signal
as the function of both time and frequency. Figure 3-5 shows a
frequency-time spectral map computed by performing a Gabor transform
on a sample vibration signal from a rotating machine. The horizontal axis
denotes time, and the vertical axis denotes frequency. The magnitudes of
coefficients are denoted by gray scale, with full white areas indicating a
maximal magnitude and full black areas indicating a minimal magnitude.

Figure 3-5. Frequency-Time Spectral Map of a Vibration Signal
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Because the rotational speed changes little in each time portion of the
frequency-time spectral map, the spectrum of each order can be clearly
distinguished. As the rotational speed varies over time, the frequency of one
certain order component changes. Thus, it forms a curve with a large
magnitude in the frequency-time spectral map, as shown in Figure 3-5. The
white curves have magnitudes larger than the magnitudes in local
neighborhoods off the curves. These white curves indicate the order
components and are referred to as order curves.

From the frequency-time spectral map, we can separate the order curves,
or any other part of the signal in which we are interested, from the intact
original signal. Then, time waveforms of the orders can be reconstructed
using the Gabor expansion.

Figure 3-6 illustrates the order analysis process which the Order Analysis
Toolset for LabVIEW follows. The toolset completes the following steps
when performing order analysis.

1. Acquires data samples from tachometer and noise or vibration sensors
synchronously at some constant sample rate.

2. Performs Gabor transform on the noise or vibration samples to
produce an initial Gabor coefficient array.

3. Calculates rotational speed from the tachometer signal.

4. Generates a 2D spectral map from the initial coefficient array to
observe the whole signal over frequency-time, frequency-RPM,
order-RPM, or RPM-order.

5. Generates a modified coefficient array, based on the rotational speed
and the order of interest, from the initial array by performing a
masking operation.

6. Generates a time domain signal from the modified coefficient array by
performing a Gabor expansion.

7. Calculates the waveform magnitude as a function of RPM.
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Figure 3-6. Order Analysis Diagram

Extracting the Order Components
After the initial Gabor coefficient array is generated through Gabor
transform, one or more order components may be selected for analysis.
The coefficient corresponding to the selected order component may be
converted back into a time domain signal. The resulting time domain signal
contains information only on the selected order component.

The selection of order components can be achieved by inclusion of the
coefficients along the corresponding order curves. Therefore, the position
index of the coefficient on each order curve must be determined. Because
the frequency of an order component is an integer or fractional multiple of
the fundamental frequency, such as the rotational speed, the position index
of a given order curve at each time interval can be calculated by multiplying
the order number and the fundamental frequency index at the time interval.
If a signal sampled at the frequency fs is processed by Gabor transform with
N frequency bins, which equals the window length in this toolset, the index
of the nth order can be calculated by the following formula:

RPM is the averaged instantaneous rotational speed in the time interval.
Refer to the Tachometer Signal Processing section of this chapter for
information about obtaining the rotational speed.

Each order component in the order domain, as well as each harmonic in
the frequency domain, has a side band. Thus, in the joint time-frequency
domain, each order component contains not only the coefficients along the
order curve, but also some coefficients in the neighborhood. These
coefficients in the neighborhood also must be included when selecting the
order component.
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Constant frequency bandwidth and constant order bandwidth are two ways
to define the bandwidth of the neighborhood for an order curve.

Figure 3-7(a) illustrates constant frequency bandwidth. The neighborhood

is considered as the region between and , where

∆f is a constant frequency. The frequency of the bandwidth, ∆f, remains

constant over time.

Figure 3-7(b) illustrates constant order bandwidth. The neighborhood is

considered as the region between and .

While the frequency bandwidth varies in time, the order bandwidth

k remains constant.

Figure 3-7. Mask Schemes

n
RPM

60
------------- ∆f

2
-----+ n

RPM
60

------------- ∆f
2
-----–

n
k
2
---+ 

  RPM
60

-------------× n
k
2
---– 

  RPM
60

-------------×

k
RPM

60
-------------

500–

400–

300–

200–

100–

0–
0 5 25 30 3510 15 20 39

Time (s)
(a) Constant Frequency Bandwidth

0 5 25 30 3510 15 20 39
Time (s)

(b) Constant Order Bandwidth

Fr
eq

ue
nc

y
(H

z)

500–

400–

300–

200–

100–

0–

Fr
eq

ue
nc

y
(H

z)



Chapter 3 Order Analysis Algorithm

Order Analysis Toolset User Manual 3-10 ni.com

The frequency bandwidth or order bandwidth can be determined
automatically or in response to your input. For example, a bandwidth
can be automatically determined for the time-frequency neighborhood
based on an estimate of minimum order-distance to nearest neighbor
order-components. Normally, the bandwidth should not exceed the distance
between two nearby orders, which is the fundamental frequency, or first
order.

After you determine the coefficient positions and the bandwidth of the
given order curves, select a subset of the initial Gabor coefficient array.
This subset contains only the coefficients in the neighborhood of the
selected order curves and can be generated from the original array by
performing a mask operation.

To perform the mask operation, you must construct a mask array. The mask
array is a 2D array the same size as the coefficient array, but all of the mask
array elements are Boolean. When masking is performed, the coefficients
at value TRUE are kept unchanged, while the coefficients at value FALSE
are set to zero. The following formula represents the mask operation:

where cm,n denotes the initial Gabor coefficient array; denotes the
masked coefficient array; and maskm,n denotes the mask array.

A mask array can be built according to the order number you wish to
analyze. In each row, elements within the bandwidth of the designated
order number are set to either TRUE or FALSE. The Order Analysis
Toolset for LabVIEW contains the Template to Mask VI, which you can use
to perform the mask operation. Refer to the Order Analysis Toolset for
LabVIEW Help, available by selecting Help»Order Analysis, for more
information about the Template to Mask VI.

The mask operation can be considered a time-variant band pass filter in the
joint time-frequency domain. The center frequency of the pass band is
equal to the frequency of the order curve. The number of elements set to
TRUE determines the bandwidth of the pass band.

ĉm n,
cm n, maskm n, TRUE=

0 maskm n, FALSE=



=

ĉmn
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Figures 3-8 and 3-9 illustrate the order extraction and signal reconstruction
process, with the time waveform shown in Figure 3-9.

Figure 3-8. Gabor Coefficients

Figure 3-8(a) shows a frequency-time spectral map after Gabor transform.

Figure 3-8(b) shows a mask array around the fourth order with a constant
frequency bandwidth. The TRUE values compose the white area, while the
FALSE values compose the black areas.

Figure 3-8(c) shows the masked coefficients. The black areas indicate
values set to zero, which correspond to the FALSE values in the mask array.
The white area contains values copied from the original coefficient array.
These values correspond to the TRUE values in the mask array.

Figure 3-8(d) shows the frequency-time spectral map of the reconstructed
signal.
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Figure 3-9 shows the fourth order waveform, which was reconstructed by
performing Gabor expansion on the masked coefficients.

Figure 3-9. Original Signal and Extracted Order Component

Unlike the reverse discrete Fourier transform, the Gabor expansion, in
general, is not a one-to-one mapping. A Gabor coefficient is the sub-space
of a two-dimensional function. For an arbitrary two-dimensional function,
such as the masked coefficient array, there might be no corresponding time
waveform. Usually, the Gabor coefficients of the reconstructed time
waveform might not be exactly the same as the desired coefficients you
masked, but they are the closest in terms of the least mean square error
(LMSE).

Like conventional time-invariant filters, the time-variant filters
implemented by the Gabor expansion have a certain passband and
attenuation. The extracted time waveform is only a part of the original
signal whose frequencies fall into the passband determined by the Gabor
time-variant filters. In Figure 3-10, one row is selected from the joint
time-frequency coefficient array. The selected row is nothing more than a
windowed FFT power spectrum in the time interval. The original Gabor
coefficients compose the solid line in Figure 3-10. When performing a
mask operation, coefficients outside the expected pass band are set to zero.
After reconstruction, the spectrum of the reconstructed signal is formed. In
Figure 3-10, the dashed line represents the spectrum of the reconstructed
signal. Within the pass band, the reconstructed signal keeps the same
magnitude as the original signal. While outside the pass band, the
magnitude of the reconstructed signal is no longer zero. Instead, the
magnitude does have some certain value, but the value decreases quickly as
the frequency leaves the pass band.
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Figure 3-10. Spectrum of Reconstructed Signal

Displaying Spectral Maps
Before extracting order components from the joint time-frequency domain,
you might want to find which order components you are most interested in,
such as which order is the most significant or which order contributes the
most at a certain rotational speed. Yet, by using order extraction and
reconstruction, you might have to process a large number of order
components before you can obtain this information.

The Order Analysis Toolset for LabVIEW provides several methods of
obtaining a 2D spectral map over the whole signal in the frequency-time,
frequency-RPM, and order-RPM domains. Figure 3-11 shows these three
types of spectral maps for a vibration signal.
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Figure 3-11. 2D Intensity Plots

Figure 3-11(a) is the frequency-time spectral map generated directly from
the Gabor coefficients. The horizontal axis denotes time, and the vertical
axis denotes frequency. The magnitudes of coefficients are shown as gray
scale, with full white indicating a maximal magnitude and full black
indicating a minimal magnitude. Order components are shown as curves.
Because the frequency of each order component shifts as the rotational
speed varies over time, the outline of each curve is similar to the RPM-time
function shown in Figure 3-11(b).

In Figure 3-11(a), there are some horizontal white lines. These white lines
indicate the large power around the resonance frequencies. The physical
characteristics of the system containing the rotating machinery determine
the resonance frequency. The resonance frequency does not change as the
rotational speed changes.
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Figure 3-11(c) shows the frequency-RPM spectral map. The horizontal
axis represents RPM, or rotational speed. The RPM axis can be mapped
from the time axis in the frequency-time spectral map by the RPM-time
function. The frequency of each order component can be calculated by
using the following formula:

Because it is a linear function between RPM and frequency, order

components appear as lines with a slope of in Figure 3-11(c).

The resonance beams appear as horizontal lines.

Applying a frequency-to-order-number transform to the frequency-RPM
spectral map generates the order-RPM spectral map, shown in
Figure 3-11(d). The order-RPM spectral map displays the order
components as horizontal lines and the resonance beams as hyperbolas.

Using the frequency-time spectral map, the frequency-RPM spectral map,
and the order-RPM spectral map, you can clearly and efficiently observe all
the order components in the entire time and RPM ranges.

Calculating Waveform Magnitude
The reconstructed time waveform of the selected order contains only a few
frequency components in a relatively short time interval. Thus, it displays
like a sine waveform in which the frequency and magnitude have been
modulated.

In practical applications, such as product testing for comparison with
reference curves, it is useful to calculate the waveform magnitude as a
function of RPM. The Order Analysis Toolset for LabVIEW uses the root
mean square (RMS) of the time waveform to calculate the waveform
magnitude. The magnitude at each time instance is the RMS in a short time
interval around the time instance. By means of the time-RPM function, the
Order Analysis Toolset performs a mapping operation from time to RPM to
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obtain the waveform magnitude as a function of RPM. The following
equation represents the mapping operation:

, for any , have

where Xi represents the waveform data samples, M(RPM) represents the
magnitude at speed RPM, rpm(i) represents the rotational speed at time
sample i, and represents the RPM resolution.

Tachometer Signal Processing
In order to successfully extract the order components, create the spectral
map display, and calculate the waveform magnitude, you need rotational
speed as a function of time during the data acquisition process.
Traditionally, the two methods used to calculate rotational speed have been
counting pulses in a given time interval and timing the interval between
given pulses.

The Order Analysis Toolset for LabVIEW uses a non-causal filter to
calculate rotational speed. The length of the non-causal filter is five, two
before and two after the current time instant. Because all the data in the test
process is available when doing offline analysis, the Order Analysis Toolset
for LabVIEW can use tachometer pulses occurring before and after each
time instance when calculating rotational speed. Using tachometer pulses
occurring before and after each time instance improves the accuracy of the
calculated rotational speed.

Figure 3-12 illustrates a typical tachometer pulse train and the cumulative
rotation angle θ of the shaft as a function of time t. The arrival time tk of the
pulses P(k) in the tachometer signal correspond to the cumulative rotation
angle θ(tk). The cumulative rotation angle function θ(t) increases by a fixed
angle ∆θ in the time interval between times tk and tk+1. As shown in the
following equation, rotational speed can then be presented as the first
derivative of θ(t):

M RPM( )
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---------------- Xi
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Figure 3-12. Tachometer Signal and Rotation Angle

While the time interval between pulses varies with the rotational speed, the
cumulative angle increment remains constant. Instead of observing θ(t)
directly, we chose to observe t(θ). t(θ) is the inverse function of θ(t).

For the evenly separated function series tk, the first derivative can be
calculated with the following formula:
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Rotational speed at each pulse-arrival-time instant will then be calculated
by the following formula:

This algorithm gives the third-order approach of the rotational speed, but it
is sensitive to measurement error. Either a tachometer pulse with a slow
slew rate or a low tachometer sampling rate causes an inaccurate
determination of the pulse arrival time. As a result, an even larger error in
the calculated rotational speed occurs.

If either a tachometer pulse with a slow slew or a low tachometer sampling
rate is encountered, a low-order approach can be used. The following
formula is an example of a low-order approach:

An alternative to the low-order approach is averaging the pulses. One of the
averaging approaches considers two or more pulses as a single pulse by
decimating the original tk series. Also, the angle increment between two
sequential pulses must be multiplied by the corresponding factor. Because
the measurement error of the pulse arrival time is non-cumulative,
widening the pulse interval decreases the relative error.

ω tk( ) dθ
dt
------

t tk=

1
dt
dθ
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θ θk=

--------------------= =

dt
dθ
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θ θ1=
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Figure 3-13 shows an example of the rotational speed calculated from the
tachometer pulses. One of the results is calculated with no average, while
another is averaged by five. As Figure 3-13 shows, the averaged rotational
speed is smoother than the non-averaged rotational speed.

Figure 3-13. Cumulative Revolution and Rotational Speed
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4
Example VIs

This chapter describes the example VIs for the Order Analysis Toolset for
LabVIEW.

Overview of Example VIs
The example VIs illustrate the following Order Analysis Toolset for
LabVIEW functions for both analog and digital tachometer signal
processing:

• Compute Order Spectrum

• Compute Spectral Map

• Extract Individual Orders

• Extract Most Significant Orders

• Extract Sum of Orders

The example VIs are built around high-level VIs and are intended to
illustrate the basic capabilities of the Order Analysis Toolset for LabVIEW.
The toolset contains intermediate and advanced VIs to provide you with
LabVIEW programming experience flexibility in application design.

In addition to the example VIs, the Order Analysis Toolset for LabVIEW
CD contains the Order Analysis Start-Up Kit. With the start up kit, you can
see a more extensive example of the capabilities of the toolset. Refer to the
Order Analysis Start-Up Kit section of Chapter 1, Introduction, in this
manual for more information about the Order Analysis Start-Up Kit.

Accessing the Example VIs
You can access the example VIs from either the LabVIEW dialog box or
the LabVIEW toolbar. After you have opened the example VI you want to
see, select Window»Show Diagram from the front panel toolbar to view
the block diagram for the example.



Chapter 4 Example VIs

Order Analysis Toolset User Manual 4-2 ni.com

LabVIEW Dialog Box
Complete the following steps to access the Order Analysis Toolset for
LabVIEW example VIs from the LabVIEW dialog box.

1. Start LabVIEW.

2. Click the Open VI button in the LabVIEW dialog box.

3. Navigate to Program Files\National 

Instruments\LabVIEW 6\examples\Order Analysis

4. Double-click the file name of the LabVIEW library you want to open,
either Analog Tach Examples.llb or Digital Tach 
Examples.llb, or highlight the file name and click the Open button
in the Choose the VI to open dialog box.

5. Double-click the name of the example VI you want to open or
highlight the VI name and click the OK button in the File Dialog
dialog box.

LabVIEW Toolbar
Complete the following steps to access the Order Analysis Toolset for
LabVIEW example VIs from the LabVIEW toolbar.

1. Select File»Open from the LabVIEW toolbar.

2. Complete steps 3 through 5 in the LabVIEW Dialog Box section of this
chapter.

Data Acquisition
For all the example VIs, you can use pre-recorded data, or you can acquire
your own data. Each example VI has a Boolean control named Data
Source. This control has two choices, Example and DAQ. When you
choose Example, the VI uses pre-recorded data generated during a fan
run-up as the data source. When you choose DAQ, the VI uses data you
acquire with your own data acquisition (DAQ) hardware.

When you set Data Source to DAQ and click the run button, the window
shown in Figure 4-1 opens. You must configure two channels of the DAQ
device in order to acquire data. Use Tach Channel for the tachometer
signal and S/V Channel for the sound or vibration sensor. After choosing
your data acquisition settings, use the Tach Pulse/Rev control to specify
the number of pulses the tachometer generates per revolution. Use the S/V
Channel Info control to specify the channel information for the sound or
vibration sensor.
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Figure 4-1. Configure Data Settings

After properly configuring your DAQ device, click the Acquisition tab.
The Acquisition tab, shown in Figure 4-2, allows you to acquire data and
to observe the data acquisition. Click the Acquire button to acquire data.
Continue to configure the data acquisition and observe the data until you
acquire the proper data. Click the OK button to analyze the data.
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Figure 4-2. Acquire Data

When acquiring data through your DAQ hardware, National Instruments
recommends adhering to the following guidelines:

• Use an anti-aliasing filter before data acquisition to avoid the
frequency alias.

• Sample the data from different channels simultaneously to maintain
the phase relationship between channels, such as a tachometer signal
and a vibration signal.
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Compute Order Spectrum
The Compute Order Spectrum example demonstrates the use of the
simplified order spectrum to analyze the noise or vibration signal generated
by a rotating machine at an essentially constant rotational speed. Figure 4-3
shows the Compute Order Spectrum Example VI front panel.

Figure 4-3. Compute Order Spectrum Example

The N&V Samples graph displays the vibration signal. The Order
Spectrum graph displays the order spectrum of the data gathered between
the two cursors of the N&V Samples graph.
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In the pre-recorded data, the rotational speed increases significantly over
time. However, within the relatively short time interval between the two
cursors of the N&V Samples graph, the rotational speed hardly changes and
can be considered to be constant. The different order components can be
clearly separated in the Order Spectrum graph.

If you drag the two cursors of the N&V Samples graph to another area of
the graph, the Order Spectrum display adjusts accordingly. If the new data
range is too large, there will be some smearing in the order spectrum plot.
This is because the rotational speed changes too much within the larger
range for the speed to be considered constant.

Compute Spectral Map
The Compute Spectral Map example demonstrates how to use different
types of intensity plots to observe the whole signal over RPM-order,
order-RPM, frequency-time, and frequency-RPM. Figure 4-4 shows the
Compute Spectral Map example VI front panel. The default for Type is
RPM-Order, and the default for dB On? is Yes.

The default setting of RPM-Order generates a spectral map with RPM on
the Y axis and order on the X axis. In the Spectral Map display, each order
component appears as a vertical line. With the RPM-Order setting, you can
observe the difference between order components and how the order
components vary from the rotational speed.

If Type is set to Order-RPM, the VI displays the order-RPM spectral map,
with order on the Y axis and RPM on the X axis. With the Order-RPM
setting, you can observe the difference between order components and how
the order components vary from the rotational speed.

If Type is set to Frequency-Time, you can observe the signal power
distribution as a function of frequency and time, with frequency on the Y
axis and time on the X axis. In the Spectral Map display, each order
component appears as a curve with an outline similar to the RPM-time
function.

If Type is set to Frequency-RPM, you can view the signal power
distribution over frequency and RPM, with frequency on the Y axis and
RPM on the X axis. The order components appear as straight lines in the
Spectral Map display.
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Figure 4-4. Compute Spectral Map Example

Setting dB ON? to Yes enhances the Spectral Map display, because the
original magnitudes have a large dynamic range. When dB ON? is set to
No, Spectral Map displays the original power.
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Extract Individual Orders
The Extract Individual Orders example uses the Order Analysis Toolset for
LabVIEW Order Tracking VI and extracts a set of order components from
the original signal. The example VI displays the order components in both
time waveform and magnitude versus RPM formats. Figure 4-5 shows the
Extract Individual Orders Example VI front panel.

Figure 4-5. Extract Individual Orders Example
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Enter a series of order numbers in the Orders control and click the run
button. When the VI finishes, the time waveform of both the original signal
and the extracted order components appears in the Order Waveforms graph.
The overall level as a function of RPM appears in the Magnitude vs. RPM
graph.

You can change the View Mode setting to Amplitude, dB, or Power.
The default is Amplitude. Changing the View Mode setting changes the
display format of the Magnitude vs. RPM graph.

Extract Most Significant Orders
The Extract Most Significant Orders example demonstrates how to find the
most significant orders in a given signal using the Significant Order
Tracking VI from the Order Analysis Toolset for LabVIEW. Figure 4-6
shows the Extract Most Significant Orders Example VI front panel.



Chapter 4 Example VIs

Order Analysis Toolset User Manual 4-10 ni.com

Figure 4-6. Extract Most Significant Orders Example

You specify how many of the most significant orders you want to find with
the Number of Significant Orders control. When the VI finishes, the
order numbers of the most significant orders appear in the Most Significant
Orders indicator. The waveforms of orders, as well as the original signal,
appear in the Time Waveform graph. The magnitudes appear in the
Magnitude vs. RPM graph as a function of the rotational speed in RPM.
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Extract Sum of Orders
The Extract Sum of Orders example demonstrates how to extract a
combination of orders in a given signal using Advanced Order Analysis
VIs from the Order Analysis Toolset for LabVIEW. Figure 4-7 shows the
Extract Sum of Orders Example VI front panel.

Figure 4-7. Extract Sum of Orders Example
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Enter a series of order numbers in the Orders control and click the run
button. When the VI finishes, the waveform of the original signal and the
combination of the orders appear the Time Waveform graph. The
magnitude appears in the Magnitude vs. RPM graph as a function of the
rotational speed in RPM.



© National Instruments Corporation A-1 Order Analysis Toolset User Manual

A
Gabor Expansion and
Gabor Transform

This appendix presents a basic discussion of the Gabor expansion and the
Gabor transform methods used in the Order Analysis Toolset for LabVIEW.
It also discusses application issues associated with using the discrete
Gabor-expansion based time-varying filter.

Gabor Expansion and Gabor Transform Basics
The Gabor expansion, a mathematical tool, characterizes a signal jointly in
the time and frequency domains. Although Nobel laureate Dennis Gabor
introduced the Gabor expansion more than half a century ago, its
implementation had been an open research topic until Bastiaans discovered
the relationship between the Gabor expansion and the short-time Fourier
transform (STFT) in the early 1980s. Over the years, many different
implementation schemes for the discrete Gabor expansion have been
proposed. The one employed in the Order Analysis Toolset for LabVIEW
is an extension of the method originally developed by Wexler and Raz. In
this method, lengths of the analysis and synthesis window functions are the
same, while perfect reconstruction is guaranteed.

For a discrete sample s[k], the corresponding Gabor expansion is defined
by the following equation:

(A-1)

where the Gabor coefficients cm,n are computed by a sampled STFT. The
sampled STFT is also known as the Gabor transform and is represented by
the following equation:

(A-2)

s k[ ] cm n,

n 0=

N 1–

∑
m

∑ h k m∆M–[ ]ej2πnk N⁄=

cm n, s̃ k[ ]γ∗ k m∆M–[ ]e j2πnk– N⁄

n 0=

N 1–

∑=
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where ∆M represents the time sampling interval and N represents the total
number of frequency bins. The ratio between N and ∆M determines the
Gabor sampling rate. For numerical stability, the Gabor sampling rate must
be greater than or equal to one. Critical sampling occurs when N = ∆M. In
critical sampling, the number of Gabor coefficient cm,n equals the number
of original data samples s[k]. Over sampling occurs when N/∆M > 1. For
over sampling, the number of Gabor coefficients is more than the number
of original data samples. In over sampling, the Gabor transform in
Equation A-2 contains redundancy, from a mathematical point of view.
However, that redundancy provides freedom for the selection of better
window functions, h[k] and γ[k].

Note that the positions of the window functions h[k] and γ[k] are
interchangeable. In other words, either of them can be used as the synthesis
or analysis window function. Therefore, we usually refer to h[k] and γ[k] as
dual functions.

The method developed here requires in Equation A-2 to be a periodic
sequence, as follows:

(A-3)

where Ls represents the length of the signal, s[k], and L0 represents the
period of the sequence . L0 is the smallest integer that is greater than
or equal to Ls, and it must be evenly divided by the time sampling interval
∆M. For a given window h[k] that always has unit energy, we can compute
the corresponding dual window function from ∆M independent linear
systems with the following equation:

(A-4)

where L denotes the window length. denotes a periodic auxiliary
function1 given by

1 If the window length is equal to the signal length, the periodic auxiliary function is simply

s̃ k[ ]

s̃ k iL0+[ ]
s k[ ] 0 k Ls<≤
0 Ls k L0<≤




=

s̃ k[ ]

ã k p∆M qN+ +[ ]γ∗ k p∆M+[ ]

p 0=

L
∆M
--------- 1–

∑ δ q[ ]
N

-----------= 0 k ∆M<≤

ã k[ ]

ã k[ ]
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L
N
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Note that the solution of Equation A-4 is not unique for over sampling. A
particularly interesting solution for Equation A-4 is least mean square error
(LMSE). It can be shown that for the LMSE solution, the Euclidean
distance between the dual functions is minimum

where denotes the matrix form of Equation A-4. When , the
error is small, and Equation A-2 becomes

(A-5)

Equation A-5 and Equation A-1 form an orthogonal-like Gabor transform
pair. In the case of an orthogonal-like Gabor transform pair, the Gabor
coefficients cm,n are the projection of the signal on the synthesis window
function h[k].

Discrete Gabor-Expansion Based Time-Varying Filter
At first glance, the discrete Gabor expansion seems to provide a feasible
vehicle for converting an arbitrary signal from the time domain into the
joint time-frequency domain or vice versa. As a matter of fact, it is only true
for critical sampling ∆M = N. For over sampling, which is the case for most
applications, the Gabor coefficients are the sub-space of two-dimensional
functions. In other words, for an arbitrary two-dimensional function, there
might be no corresponding time waveform. For example, assume that we
have the following modified two-dimensional function:

ã k i 2L N–( )+[ ] h k[ ] 0 k L<≤
0 L k 2L N–<≤




= 0 q
2L
N
------ 1–<≤

minAγ u=
γ

γ
----- h–

Aγ µ= γ h≈

cm n, s̃

m

∑ k[ ]h k mT–[ ]e
j2πnk– N⁄≈

ĉm n, Φm n, cm n,=
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where Φm, n denotes a binary mask function whose elements are either zero
or one. Then, apply the Gabor expansion to obtain

We will find

The Gabor coefficients of the reconstructed time waveform will not
be equal to the selected Gabor coefficients .

To overcome this problem, we apply an iteration. That is, for a set of
two-dimensional Gabor coefficients, first determine a binary mask matrix.
Apply the mask to the two-dimensional Gabor coefficients to preserve
desirable coefficients and remove unwanted coefficients. Then, compute
the Gabor expansion. Once the time waveform is obtained, compute the
new Gabor coefficients. Repeat this process until the time waveforms
converge.

Without a loss of generality, let us rewrite the Gabor expansion from
Equation A-1 and the Gabor transform from Equation A-2 in matrix form

where H denotes the analysis matrix and G denotes the synthesis matrix.
Note that for over sampling

Then in the case of over sampling, the iterative process can be described as

ŝ k[ ] cm n,

n 0=

N 1–

∑
m

∑ h k mT–[ ]ej2πnk N⁄=

ŝ

m

∑ k[ ]γ k mT–[ ]e
j2πnk– N⁄

ĉm n,≠

ŝ k[ ]
ĉm n,

C Gs=

s HTGs=

HTG I= GHT I≠

Ĉ
1
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It can be shown that Ck and converge and that with .
For with , the support of Ck in the time-frequency
domain is inside the masked area, if and only if

(A-6)

for 0 ≤ k < N and 0 ≤ m < . Two trivial cases for Equation A-6 are

critical sampling and when γ[k] = h[k].

In critical sampling, N = ∆M. Note that in this case, the analysis and
synthesis windows cannot both be localized in the joint time-frequency
domain.

In the case of γ[k] = h[k], the Gabor coefficients C2, after the first iteration,
are the closest in terms of LMSE to the masked Gabor coefficients ΦC. The
masked Gabor coefficients are the desirable Gabor coefficients. The case of
γ[k] = h[k] usually implies considerable over sampling, which results in a
huge amount of redundancy. The amount of redundancy causes slow
computation speed and huge memory consumption, making γ[k] = h[k] an
impractical Gabor Transform method.

Usually, we pursue the orthogonal-like representation introduced at the end
of the Gabor Expansion and Gabor Transform Basics section of this
appendix. It has been found that for commonly used window functions,
such as the Gaussian and Hanning windows, the difference between the
analysis and synthesis windows is negligible when the over sampling rate
is four.
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C
Technical Support Resources

Web Support
National Instruments Web support is your first stop for help in solving
installation, configuration, and application problems and questions. Online
problem-solving and diagnostic resources include frequently asked
questions, knowledge bases, product-specific troubleshooting wizards,
manuals, drivers, software updates, and more. Web support is available
through the Technical Support section of ni.com

NI Developer Zone
The NI Developer Zone at ni.com/zone is the essential resource for
building measurement and automation systems. At the NI Developer Zone,
you can easily access the latest example programs, system configurators,
tutorials, technical news, as well as a community of developers ready to
share their own techniques.

Customer Education
National Instruments provides a number of alternatives to satisfy your
training needs, from self-paced tutorials, videos, and interactive CDs to
instructor-led hands-on courses at locations around the world. Visit the
Customer Education section of ni.com for online course schedules,
syllabi, training centers, and class registration.

System Integration
If you have time constraints, limited in-house technical resources, or other
dilemmas, you may prefer to employ consulting or system integration
services. You can rely on the expertise available through our worldwide
network of Alliance Program members. To find out more about our
Alliance system integration solutions, visit the System Integration section
of ni.com
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Worldwide Support
National Instruments has offices located around the world to help address
your support needs. You can access our branch office Web sites from the
Worldwide Offices section of ni.com. Branch office Web sites provide
up-to-date contact information, support phone numbers, e-mail addresses,
and current events.

If you have searched the technical support resources on our Web site and
still cannot find the answers you need, contact your local office or National
Instruments corporate. Phone numbers for our worldwide offices are listed
at the front of this manual.
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Glossary

Numbers/Symbols

Infinity.

2D Two-dimensional.

A

adaptive filter A type of filter which operates on a recursive algorithm to achieve the goal
of optimum. It is self-designing and suitable for tracking time variations of
the input signal, but complete knowledge of the relevant signal
characteristics is not available.

aliasing A phenomenon in which an analog signal of a frequency greater than half
the sampling frequency, or Nyquist frequency, appears after sampling at a
frequency less than half the sampling frequency. See also anti-aliasing filter
and Nyquist frequency.

anti-aliasing filter Analog lowpass filters used before analog to digital conversion to filter out
the frequencies greater than half the sampling frequency. See also aliasing
and Nyquist frequency.

C

critical sampling Occurs in Gabor transform when the window length equals the window
shift step. In critical sampling, the number of Gabor coefficients cm,n equals
the number of original data samples s[k].

D

dB Decibel.

dual functions Window functions for Gabor transform and Gabor expansion. They are
interchangeable, and either of them can be used in Gabor transform, while
the other is used in Gabor expansion.

∞
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F

FFT Fast Fourier transform.

G

Gabor coefficient The result of Gabor transform.

Gabor expansion The inverse Gabor transform used on Gabor coefficients to recover a
time-domain input signal.

Gabor transform One of the invertible joint time-frequency transforms.

H

harmonic Frequencies that are integer or fractional multiples of a fundamental
frequency.

L

LMSE Least mean square error.

N

Nyquist frequency Half the sampling frequency. Any analog frequency component above the
Nyquist frequency will, after sampling, be converted, or aliased, to a
frequency below the Nyquist frequency. See also aliasing and anti-aliasing
filter.

O

order A harmonics related to the rotational speed of a machine.

order analysis The analysis of harmonics related to rotational speed. The application of
harmonic analysis to rotating machinery

order curves The high power density curves in a spectral map which indicate order
components.
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orthogonal-like Gabor
transform pair

The pair is composed of a Gabor transform and a Gabor expansion when
the Gabor coefficients cm,n found by each method are the projection of the
signal on the synthesis window function h[k].

over sampling Occurs in Gabor transform when the window length is greater than the
window shift step. In over sampling, the number of Gabor coefficients cm,n

is more than the number of original data samples s[k].

R

re-sampling A method to sample a time sequence at a different time interval.

RMS Root mean square.

RPM Revolutions per minute.

S

STFT Short time Fourier transform.

W

window shift step The shortest time interval between two windows. In the Order Analysis
Toolset for LabVIEW, it is always equal to a quarter (0.25) of the window
length. For example, if the window length is 2048, the window shift is 512.
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Index

A
adaptive filter method, 3-3
algorithm for order analysis. See order analysis

algorithm.
angle samples

acquisition, 3-2
conversion of time samples to angle

samples, 3-1
spectrum of angle samples

(figure), 3-2 to 3-3

B
bandwidth

bandwidth of neighborhood, 3-9
constant frequency bandwidth (figure), 3-9
constant order bandwidth (figure), 3-9

C
calculating waveform magnitude, 3-15 to 3-16
Compute Order Spectrum example VI,

4-5 to 4-6
Compute Spectral Map example VI, 4-6 to 4-7
constant frequency and amplitude (figure), 2-6
conventions used in manual, vii
customer education, C-1

D
data acquisition for example VIs, 4-2 to 4-4
discrete Gabor-expansion based time-varying

filter, A-3 to A-5
displaying spectral maps, 3-13 to 3-15

frequency-RPM spectral map
(figure), 3-14 to 3-15

frequency-time spectral map (figure), 3-14

order-RPM spectral map
(figure), 3-14 to 3-15

RPM-time function (figure), 3-14
documentation

conventions used in manual, vii
related documentation, vii-viii

E
example VIs, 4-1 to 4-12

accessing, 4-1 to 4-2
LabVIEW dialog box, 4-2
LabVIEW toolbar, 4-2

Compute Order Spectrum, 4-5 to 4-6
Compute Spectral Map, 4-6 to 4-7
data acquisition, 4-2 to 4-4
Extract Individual Orders, 4-8 to 4-9
Extract Most Significant Orders, 4-9 to 4-10
Extract Sum of Orders, 4-11 to 4-12
overview, 4-1

Extract Individual Orders example VI, 4-8 to 4-9
Extract Most Significant Orders

example VI, 4-9 to 4-10
Extract Sum of Orders example VI, 4-11 to 4-12
extracting order components, 3-8 to 3-13

bandwidth of neighborhood, 3-9
coefficients in the neighborhood, 3-8 to 3-9
constant frequency bandwidth (figure), 3-9
constant order bandwidth (figure), 3-9
Gabor coefficients

frequency-time spectral map
(figure), 3-11

mask array (figure), 3-11
masked coefficients (figure), 3-11
original signal and extracted order

components (figure), 3-12
reconstructed waveform, 3-12
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index of nth order, 3-8
mask array and mask operation, 3-10
mask schemes (figure), 3-9
passband and attenuation, 3-12
selecting order components, 3-8
spectrum of reconstructed signal

(figure), 3-13

F
fast Fourier transform (FFT), 2-4, 3-2
filters

adaptive filter method, 3-3
discrete Gabor-expansion based

time-varying filter, A-3 to A-5
Vold-Kalman Order Tracking Filter, 3-3

frequency content changes over time
(figure), 2-6 to 2-7

frequency domain
formula for switching to order

domain, 2-2
order and frequency domain display of

rotating shaft (figure), 2-2
frequency-time spectral map

computed by STFT, 2-4
constant frequency and amplitude

(figure), 2-6
vibration signal (figure), 3-6

G
Gabor coefficients

discrete Gabor-expansion based
time-varying filter, A-3 to A-5

frequency-time spectral map
(figure), 3-11

mask array (figure), 3-11
masked coefficients (figure), 3-11
original signal and extracted order

components (figure), 3-12
reconstructed waveform, 3-12

Gabor expansion
basic principles, A-1 to A-3
discrete Gabor-expansion based

time-varying filter, A-3 to A-5
Gabor transform, 3-4 to 3-6

basic principles, A-1 to A-3
basis for Order Analysis Toolset

algorithm, 3-6 to 3-7
ensuring reconstruction, 3-4
selecting order components, 3-8
wrap padding, 3-4

padding examples (figure), 3-5
zero padding, 3-4

padding examples (figure), 3-5
padding schemes (figure), 3-5

getting started with Order Analysis Toolset for
LabVIEW, 1-3

H
harmonic analysis

frequency changes over time
(figure), 2-6 to 2-7

order analysis as application of, 2-1
order analysis compared with, 2-4 to 2-8
PC fan running at constant RPM

(figure), 2-5
power spectrum measured over fan run-up

(figure), 2-7 to 2-8
signal with constant frequency and

amplitude (figure), 2-6

I
index of nth order, 3-8
installation

Windows 95/98/Me, 1-4
Windows NT/2000, 1-4
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M
manual. See documentation.
mask array

building, 3-10
mask array around fourth order

(figure), 3-11
mask schemes

constant frequency bandwidth
(figure), 3-9

constant order bandwidth (figure), 3-9
masked coefficients (figure), 3-11

N
neighborhood

bandwidth of neighborhood, 3-9
coefficients in the neighborhood,

3-8 to 3-9
NI Developer Zone, C-1

O
order analysis

applications, 2-9
fundamental principles, 2-1 to 2-3
harmonic analysis compared with,

2-4 to 2-8
overview, 2-1

order analysis algorithm, 3-1 to 3-19
order analysis methods, 3-1 to 3-6

adaptive filter, 3-3
Gabor transform, 3-4 to 3-6
re-sampling, 3-1 to 3-3

Order Analysis Toolset algorithm,
3-6 to 3-19

calculating waveform magnitude,
3-15 to 3-16

displaying spectral maps,
3-13 to 3-15

extracting order components,
3-8 to 3-13

Gabor transform as basis, 3-6 to 3-7
order analysis process (figure), 3-8
steps for performing order

analysis, 3-7
tachometer signal processing,

3-16 to 3-19
order analysis methods, 3-1 to 3-6

adaptive filter, 3-3
Gabor transform, 3-4 to 3-6
re-sampling, 3-1 to 3-3

Order Analysis Toolset for LabVIEW
algorithm. See order analysis algorithm.
conditions and restrictions, 1-2
getting started, 1-3
installation, 1-4
overview, 1-1
Start-Up Kit, 1-2
system requirements, 1-3

order components, extracting. See extracting
order components.

order domain
formula for switching to frequency

domain, 2-2
order and frequency domain display of

rotating shaft (figure), 2-2
order spectrum

Compute Order Spectrum example VI,
4-5 to 4-6

vibration signal from PC fan (figure), 2-3
orders

definition, 2-1
information buried in power

spectrum, 2-8
overlapping orders with rotational speed

over time (figure), 2-7 to 2-8
phase and amplitude relationships,

2-2 to 2-3
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P
phase and amplitude relationships, 2-2 to 2-3
power spectrum

constant frequency and amplitude
(figure), 2-6

power spectrum measured over fan run-up
(figure), 2-7 to 2-8

R
references, B-1
re-sampling method, 3-1 to 3-3
root mean square (RMS) of time

waveform, 3-15
RPM. See also tachometer signal processing.

calculating waveform magnitude as
function of RPM, 3-15

definition, 3-8
frequency-RPM spectral map (figure),

3-14 to 3-15
order-RPM spectral map (figure),

3-14 to 3-15
RPM-time function (figure), 3-14
time-RPM function, 3-15 to 3-16

run-up and run-down procedure
power spectrum measured over fan run-up

(figure), 2-8
purpose and use, 2-5

S
short-time Fourier transform (STFT)

computing Gabor transform, 3-4
frequency-time spectral map computed

by, 2-4
sampled STFT (equation), A-1 to A-2

spectral maps
Compute Spectral Map example VI,

4-6 to 4-7
displaying, 3-13 to 3-15

frequency-RPM spectral map
(figure), 3-14 to 3-15

frequency-time spectral map
(figure), 3-14

order-RPM spectral map (figure),
3-14 to 3-15

RPM-time function (figure), 3-14
Start-Up Kit for Order Analysis Toolset for

LabVIEW, 1-2
system integration, by National

Instruments, C-1
system requirements, 1-3

T
tachometer signal processing, 3-16 to 3-19

averaging of pulse, 3-18
calculation of first derivative, 3-17
cumulative revolution and rotational

speed (figure), 3-19
low-order approach, 3-18
rotation angle vs. time (figure),

3-16 to 3-17
rotational speed at pulse-arrival-time

instant, 3-18
rotational speed equation, 3-16
tachometer pulse train (figure),

3-16 to 3-17
technical support resources, C-1 to C-2
time samples, in re-sampling method, 3-1
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V
vibration signal

frequency-time spectral map (figure), 3-6
PC fan (figures), 2-3, 2-5

VIs
example VIs, 4-1 to 4-12

accessing, 4-1 to 4-2
Compute Order Spectrum, 4-5 to 4-6
Compute Spectral Map, 4-6 to 4-7
data acquisition, 4-2 to 4-4
Extract Individual Orders, 4-8 to 4-9
Extract Most Significant Orders,

4-9 to 4-10
Extract Sum of Orders, 4-11 to 4-12
overview, 4-1

VIs included in Order Analysis Toolset
for LabVIEW, 1-1

Vold-Kalman Order Tracking Filter, 3-3

W
waveform magnitude, calculating,

3-15 to 3-16
Web support from National Instruments, C-1
Windows 95/98/Me installation, 1-4
Windows NT/2000 installation, 1-4
Worldwide technical support, C-2
wrap padding, 3-4

padding examples (figure), 3-5

Z
zero padding, 3-4

padding examples (figure), 3-5
padding schemes (figure), 3-5
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